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ASSESSMENT

Bond Blocks Test - Student Viewing Sheet
• Place this sheet in front of the student. Use a piece of blank paper to screen items not currently being read to

the student.

• Read each test item to the student. Use your finger to point to each number and symbol as it is said.

• Students respond verbally. Student responses are recorded by the teacher on the Recording Sheet.

1)  , 8, 9

2) 5 - 3 = 
3) + 2 = 5

4) One half of 6 is 

5) 8 - 5 = 

6) + 4 = 10

7) 10 - 7 = 

8) 10 -  = 2

9) 6 - 4 = 

10) 7 - 5 = 

11)  + 5 = 8

12)  - 6 = 3

13) 3 +  = 13

14)  - 6 = 10

15) 14 - 8 = 

16) Double 7 is 

17) One half of 16 is 

18) Double 9 is 

19) 13 - 8 = 

20) - 7 = 8

Bond Blocks Test - Student Viewing Sheet

This sample contains a snippet of the assessment book that comes with the Bond 
Blocks Core Kit
These comprehensive instructions explain both using the assessment and monitoring 
the results.

Videos and further help can be freely found at bondblocks.com

 [ SAMPLE ]

Core Assessment Hub Monitoring Hub
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ASSESSMENT

Bond® 
Blocks Using the Bond Blocks Test

Organisation
The teacher will need:

i.	 A pen to record student responses.

ii.	 One copy of the ‘Bond Blocks Test - Recording Sheet’. Download and print this. Place this in front of the teacher.  

Students view the questions using either:

i.	 The Bond Blocks Test Powerpoint

There are two versions of the Bond Blocks Test PowerPoint. The written questions are identical in both versions 

however the language used to say the subtraction equations are different:

•	 In the version titled “Bond Blocks Test – Using Subtract and Equals” the subtraction questions are read using the 

words “subtract” and “equals”. For example, “Five subtract three equals?” 

•	 In the version titled “Bond Blocks Test – Using Take Away and Is” the subtraction questions are read using the 

words “take away” and “is”. For example, “Five take away three is?”

Use the version that has the language the students you are testing are most familiar with.

 

ii.	 The Bond Blocks Test - Student Viewing Sheet. 

Print one copy of this and place this in front of the student. 

 

Note: This needs to be printed separately from the Test Recording Sheet, not double-sided. Place one piece of 

blank paper on top of the Student Viewing Sheet, under the item currently being read to the student.
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Bond Blocks Test: Addition and Subtraction to 20VIEWING SHEET

Bond Blocks Test - Student Viewing Sheet
• Place this sheet in front of the student. Use a piece of blank paper to screen items not currently being read to the 

student.

• Read each test item to the student. Use your finger to point to each number and symbol as it is said.

• Students respond verbally. Student responses are recorded by the teacher on the Recording Sheet.

1) , 8, 9

2) 5 - 3 = 
3)  + 2 = 5

4) One half of 6 is 

5) 8 - 5 = 

6)  + 4 = 10

7) 10 - 7 = 

8) 10 -  = 2

9) 6 - 4 = 

10) 7 - 5 = 

11)  + 5 = 8

12)  - 6 = 3

13) 17 - 10 = 

14) 3 +  = 13

15)  - 6 = 10

16) Double 7 is 

17) One half of 16 is 

18) Double 9 is 

19) 13 - 8 = 

20)  - 7 = 8
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ASSESSMENTBond Blocks Test: Addition and Subtraction to 20

Bond Blocks Test - Recording Sheet
Student Name:

 
Class:

Complete During Test Complete After Test

Pre-Test 
Date:

Post Test 1 
Date:

Post Test 2 
Date: Teaching / Learning Focus

fluent

correct, not 
         fluent

incorrect

fluent

correct, not 
         fluent

incorrect

fluent

correct, not 
         fluent

incorrect

Highlight if not 
fluent

Bond 
Blocks 

Chapter

1 ? , 8, 9 Counting 1

2 5 - 3 = ? Bonds of 5 2

3 ?  + 2 = 5 Bonds of 5 2

4 One half of 6 is ? Double 1,2,3,4,5 
related halves 3

5 8 - 5 = ? Five Plus Bonds 4

6 ?  + 4 = 10 Bonds of 10 5

7 10 - 7 = ? Bonds of 10 5

8  10 - ?  = 2 Bonds of 10 5

9 6 - 4 = ? Bonds of 6 6

10 7 - 5 = ? Bonds of 7 6

11 ?  + 5 = 8 Bonds of 8 6

12 ?  - 6 = 3 Bonds of 9 6

13 17 - 10 = ? Ten Plus Bonds 7

14 3 + ?  = 13 Ten Plus Bonds 7

15 ?  - 6 = 10 Ten Plus Bonds 7

16 Double 7 is ? Double 6, 7, 8, 9 
related halves 8

17 One half of 16 is ? Double 6, 7, 8, 9 
related halves 8

18 Double 9 is ? Double 6, 7, 8, 9 
related halves 8

19 13 - 8 = ? Bonds of 11 to 20 9

20 ?  - 7 = 8 Bonds of 11 to 20 9

Recording Sheet Student Viewing Sheet

Bond Blocks Test Powerpoint
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ASSESSMENT

Administering the Test
Teacher Instructions
The test is administered to students one at a time. 

•	 Sit next to the student being tested.

•	 Place the Recording Sheet and pen in front of yourself.

•	 Place the test questions in front of the student. This will be either a device showing the PowerPoint or the Student 

Viewing Sheet. 

•	 Read the first test item to the student. Use your finger to point to each number and symbol as it is said aloud. 

Use terminology for ‘addition’ and ‘subtraction’ familiar to the student. The correct terms will be systematically 

introduced as students progress through the Bond Blocks activities.

Students respond verbally. Record the student’s response on the Recording Sheet using one of these symbols:

The test becomes increasingly difficult.

Tier One Class Teaching
If testing for tier one class teaching STOP testing after three errors. 

•	 Doing this will provide enough information to identify the starting point for groups of students and, in the future, 

monitor progress. 

•	 This will take approximately 3 minutes per student. Allocate between 60 to 90 minutes to test a class. 

Tier Two or Three Intervention
If testing for intervention (tier two or three) administer the whole test. 

•	 This will identify specific gaps in the student’s mathematics.

•	 Testing students who might require intervention takes longer than testing at a tier one level.  

Allow 10 to 15 minutes per student when testing students for intervention.

•	 If students are very young, have maths anxiety or attentional difficulties split the testing into two short sessions. 

Using the Bond Blocks Test 

Correct, fluent response  
Less than 3 seconds.

Incorrect or no response.Correct response but not fluent.  
Strategies greater than 3 

seconds. Includes counting.
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ASSESSMENT

Bond® 
Blocks Recording the Results

Results for multiple students can be recorded using the Bond Blocks Test - Results and Tracking Tool Excel.

Excel Tips
Download then save one copy of the file per Year Level.  File > Save As. This will help administration monitor year level 

cohorts. Class teachers can sort data by Column D “Class” to access their student list.

The Excel sheets need to be ‘unprotected’ in order to highlight rows and sort. Home > Cells > Format > Unprotect 

Sheet. This will need to be done for each sheet.

To modify, edit or sort cells in the Excel, unprotect the sheet.  
Home > Cells > Format > Unprotect Sheet.
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ASSESSMENT

Bond® 
Blocks 

The Excel spreadsheet of test results can be analysed in two ways:

1.	 Reading the horizontal rows provides student-level information. This data can be used to identify students who 

need intervention and extension. It can also be used to form groups of students working at a similar level for both 

intervention and tier one class teaching. 

2.	 Reading the vertical columns provides cohort-level information. Columns where most of the students 

experienced difficulty show gaps in teaching/learning. This is often apparent in the content areas of missing 

number equations and word questions. Once these content areas are identified use the ‘Mathematical Concepts 

Covered by Each Bond Block Activity’ table above and find activity numbers related to those topics. Complete 

these activities with the cohort. 

The table ‘Mathematical Concepts Covered by Each Bond Block Activity’ is particularly helpful when using Bond 

Blocks at a whole school level. Schools new to Bond Blocks often test the whole cohort of students, for example Year 4 

students. Doing so helps to identify (i) those who need intervention and (ii) cohort gaps in teaching/learning.

Analysing the Test Results

Mathematical Concepts Covered by Each Bond Block Activity

Activity 
Chapter

Bonds Fluency Addition Subtraction Equation 
Building

Missing 
Number 

Equations

Word 
Problems

Calculating 
Strategies

2) Bonds of 5 6 7, 8, 9 10 11 12 13 14, 15

3) Doubling 
and Halving 
to 10

16 17, 18 19, 20

4) Five Plus 
Bonds 21, 22 23 24 25

5) Bonds of 10 26 27, 28 29 30 31 32 33

6) Bonds of  
6, 7, 8, 9 34 36, 37 35 38 39 40

7) Ten Plus 
Bonds 41, 42, 43 44, 45, 47 48 (Set A) 46 48 (Set B), 

49

50, 51, 52,  
53, 54, 55, 

56

8) Doubling 
and Halving 
to 20

57 58, 59, 60, 61 62, 63

9) Bonds of 11 
to 20 64 65 66 67 68 69, 70, 71

Teacher 
Notes

Using Part-Part-Whole:  
Desk Visuals Building Equations: Using Part-Part Whole

Solving 
Missing 
Number 

Equations

Solving 
Word 

Problems

Solving 
Subtraction 

using Taking 
Away or 

Adding On

Numbers represent activity board numbers.
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ASSESSMENT

Bond® 
Blocks 

After the test the teacher uses a highlighter marker on the Recording Sheet to highlight the Teaching/Learning Foci 

column next to every response tested that was not a ‘correct fluent response’. 

If the student counted correctly to solve the test item they still need to complete the relevant chapter. The goal is 

correct, fluent responses.

Tier Level Instructions
The teacher sets activities for the student from the relevant Bond Block chapter. 

•	 For tier one whole class teaching the results will indicate the starting chapter. Students will then progress through 

all the chapters in order. 

•	 For tier two and three intervention students will progress through the activities in order but only complete the 

chapters of activities they did not give a ‘correct, fluent response’ (recorded with a tick). 

The first time students use Bond Blocks they should always engage in the Exploratory Play Activity, outlined in the 

Implementation section of the Bond Blocks website. During this activity students develop familiarity with the different 

blocks and learn the correct language for the different types of blocks.

Student Reflection and Goal Setting
Students use their test results to set learning goals using the ‘Bond 

Blocks Test - Student Reflection and Goal Setting’ sheet.

Identifying the Teaching Focus

Student Reflection 
and Goal Setting

Students need to complete the whole chapter of activities 

for every response that was not a ‘correct fluent response’. 

For example, there are three test questions for the Bonds of 10 

chapter. If a student answered two of the questions with correct 

fluent responses and one question with a correct response but 

not fluent (counted or took greater than 3 seconds, recorded 

with a C), they still have to complete the whole Bonds of 10 

chapter. This is because the questions are representative of 

typical difficulties. 

In saying this, please use teacher judgement when interpreting 

the test results. For example, if a student answers Question 1 

incorrectly but the next three questions correctly this would 

mostly likely be because they are settling into testing.  

Confirm this in a later session by asking similar questions. 

Note: Fluent responses are not an appropriate goal for students 

with diagnosed memory difficulties. Correct response is the 

appropriate goal for these students.
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ASSESSMENTBond Blocks Test: Addition and Subtraction to 20

Bond Blocks Test - Recording Sheet
Student Name:

 
Class:

Complete During Test Complete After Test

Pre-Test 
Date:

Post Test 1 
Date:

Post Test 2 
Date: Teaching / Learning Focus

fluent

correct, not 
         fluent

incorrect

fluent

correct, not 
         fluent

incorrect

fluent

correct, not 
         fluent

incorrect

Highlight if not 
fluent

Bond 
Blocks 

Chapter

1 ? , 8, 9 Counting 1

2 5 - 3 = ? Bonds of 5 2

3 ?  + 2 = 5 Bonds of 5 2

4 One half of 6 is ? Double 1,2,3,4,5 
related halves 3

5 8 - 5 = ? Five Plus Bonds 4

6 ?  + 4 = 10 Bonds of 10 5

7 10 - 7 = ? Bonds of 10 5

8  10 - ?  = 2 Bonds of 10 5

9 6 - 4 = ? Bonds of 6 6

10 7 - 5 = ? Bonds of 7 6

11 ?  + 5 = 8 Bonds of 8 6

12 ?  - 6 = 3 Bonds of 9 6

13 17 - 10 = ? Ten Plus Bonds 7

14 3 + ?  = 13 Ten Plus Bonds 7

15 ?  - 6 = 10 Ten Plus Bonds 7

16 Double 7 is ? Double 6, 7, 8, 9 
related halves 8

17 One half of 16 is ? Double 6, 7, 8, 9 
related halves 8

18 Double 9 is ? Double 6, 7, 8, 9 
related halves 8

19 13 - 8 = ? Bonds of 11 to 20 9

20 ?  - 7 = 8 Bonds of 11 to 20 9

Recording for Pre-Test, Post 
Test 1 and Post Test 2.

Related teaching and 
learning focus.

Test Item
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ASSESSMENT

Bond® 
Blocks Monitoring Progress

For teachers who prefer to use physical recording methods, progress can be monitored and observations recorded 

using the Recording Sheets. There are three levels of recording sheets:

1.	 Monitoring Sheet for an Individual Student (Tier 3 Intervention) 

This is used for tier three intervention and can be attached to students’ individual education plans. 

2.	 Monitoring Sheet for Six Students (Tier 2 Intervention) 

This is used for tier two intervention. It can also be used during differentiated tier one instruction for small groups 

of students working at a different level to the majority of the class (above or below).

3.	 Monitoring Sheet for a Class (Tier 1 Teaching) 

This is used a tier one level to monitor which students have completed which activities.

These recording sheets can be downloaded from the Assessment and Monitoring section of the website.  

They are available in a paper (PDF) and electronic (Excel) versions.

Individual Student Six Student Whole Class
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ASSESSMENT

Bond® 
Blocks Retesting

Retesting: Tier One
At a tier one level the Bond Blocks Test is administered three times:

•	 Start of Year One.

•	 End of Year One.

•	 End of Year Two.

Each time the results are recorded on a separate sheet in the Bond 

Block Test Excel Results and Tracking Tool.

The test is administered one-to-one and takes approximately 

3 minutes per student. Stop testing after three errors. The test 

becomes increasingly difficult. Doing this will provide enough 

information to identify the starting point for groups of students and, 

in the future, monitor progress. Allocate between 60 to 90 minutes to 

test a class. 

For specific test administration instructions see the ‘Administering the Bond Blocks Test Instructions’ in the Bond 

Blocks Assessment Support Book.

1.	 Pre-Test 

Administer the test to each student for the first time at the beginning of Year One, once the students have settled 

in. The test is given before the students start any Bond Block Core Activities. 

2.	 Post-Test 1 

This test is re-administered at the end of Year One to identify progress. 

3.	 Post-Test 2 

The test will not need to be administered at the start of Year Two. Instead the data from the end of Year One test 

will be used. 

The test is administered for a third time at the end of Year Two to record progress.

Retesting: Intervention 
At an Intervention Level (either tier two or three) students generally do not need to be retested using the Bond Blocks 

Test. These students are monitored using detailed Recording Sheets. The observations made and recorded on these 

recording sheets will provide much more valid information than the test. 
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ASSESSMENT

Bond Blocks Test - Recording Sheet

Student Name:

Class:

Complete During Test Complete After Test

Pre-Test 

Date:

Post Test 1 

Date:

Post Test 2 

Date:
Teaching / Learning

fluent

correct,  
not fluent

incorrect

fluent

correct,  
not fluent

incorrect

fluent

correct,  
not fluent

incorrect

Highlight if not fluent
Bond 

Blocks 
Chapter

1 ? , 8, 9 Counting 1

2 5 - 3 = ? Bonds of 5 2

3 ? + 2 = 5 Bonds of 5 2

4 One half of 6 is ? Double 1,2,3,4,5 
related halves 3

5 8 - 5 = ? Five Plus Bonds 4

6 ? + 4 = 10 Bonds of 10 5

7 10 - 7 = ? Bonds of 10 5

8  10 - ?  = 2 Bonds of 10 5

Bonds of 6 6

Bonds of 7 6

Bonds of 8 6

Bonds of 9 6

Ten Plus Bonds 7

Ten Plus Bonds 7

Ten Plus Bonds 7

Double 6, 7, 8, 9 
related halves 8

Double 6, 7, 8, 9 
related halves 8

Double 6, 7, 8, 9 
related halves 8

Bonds of 11 to 20 9

Bonds of 11 to 20 9

Bond Blocks Test - Recording Sheet

leigh
Rectangle
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ASSESSMENT

Bond Blocks Test - Student Viewing Sheet
• Place this sheet in front of the student. Use a piece of blank paper to screen items not currently being read to

the student.

• Read each test item to the student. Use your finger to point to each number and symbol as it is said.

• Students respond verbally. Student responses are recorded by the teacher on the Recording Sheet.

1)  , 8, 9

2) 5 - 3 = 
3) + 2 = 5

4) One half of 6 is 

5) 8 - 5 = 

6) + 4 = 10

7) 10 - 7 = 

10 -  = 2

Bond Blocks Test - Student Viewing Sheet

leigh
Rectangle
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ASSESSMENT

Bond Block Test - Student Reflection and Goal Setting

Name:							           Date:

Circle how you feel after your test: 

I feel like this because: 

Tick what you need to focus on:

My goal is to:

Teacher comment:

Parent comment to their child:

Counting 

Bonds of 5

Double 1, 2, 3, 4, 5 and related halves

Five Plus Bonds

Bonds of 10

Bonds of 6, 7, 8, or 9

Ten Plus Bonds

Double 6, 7, 8, 9, 10 and related halves

Bonds of 11 to 20

Bond Blocks Test - Student Reflection and Goal Setting


